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For Technical Support
How to reach us:
You can e-mail us on the Internet at support@deloach.com for "same
or next day" service (we check our mail every day).
For technical support by phone, call Darren evenings from 7:30 pm to
10:30 pm Alaska time (1 hr behind Pacific) at 907-235-2945.
You can always find the latest program updates on our World Wide
Web site at http://www.deloach.com.

Darren and Jeanne DeLoach
DeLoach.aero
PO Box 2278
Homer, AK 99603-2278
Telephone:

907-235-2945

World Wide Web:
http://www.deloach.com
EMail:
sales@deloach.com
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Section I

Overview

W

elcome to DSSLog, the easiest way to track your logged
flight time! Using DSSLog, you can easily input all of the
required flight log information including your own customdefined columns, then quickly create flight time summary and pilot
currency reports (even reports that you create) with only a few mouse
clicks.
DSSLog is the computer equivalent of your Pilot’s Logbook. Much
like your logbook, you must fill in various columns of required
information about each flight... but unlike your written logbook, with
DSSLog you’ll be able to extract useful information from your log data
in seconds with only a few clicks of your mouse!
How many hours do I have in Complex aircraft? In Tailwheel
airplanes? Floatplanes? In the last three months? Am I “IFR current”
in my approaches and instrument time? All of these questions, and
many more, can be answered by Summary and Currency reports which
you can define and print based on your logged hours. In addition to
several basic predefined reports, you can create your own
individualized record filters to produce Summary and Currency reports
which give you exactly the information you want from your logs.
In addition, DSSLog provides a useful backup of your written logbook.
Imagine your predicament if you lost your logbook... the ability to
reprint your logbook on demand in such a case is a powerful advantage
to maintaining on-line records as well as written ones.
This manual will give you all the information you need to get started
entering your logbook entries. After you have installed the software,
you’ll find more information in the on-line Help. Be sure to read
through the Help file at least once, to get a feel for how everything fits
together. You can always bring the Help file back up at any time using
the “Help” menu on the main menu line of the program, clicking on the
large “Help” button on the Main Screen, or pressing the “F1” function
key.
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Section II

Program Installation
Before Running Setup
Before you install DSSLog, make sure your computer meets
the following minimum PC requirements:

System Requirements
•
•
•
•

Microsoft Windows 95/98/NT/2K/XP
16 Megabytes of total RAM memory (or more)
6 Megabytes of free hard disk drive space
VGA Card and monitor (or better)

We welcome any comments you have on the installation and
use of our software; future enhancements (and future pilots)
depend on your feedback.

Setting Up DSSLog
1. You should already be in Microsoft Windows. CLOSE
DOWN ALL OTHER APPLICATIONS to avoid conflicts
during installation.
2. Place the CD in the appropriate disk drive, then:
• The CD will automatically start the installation if you have
Autorun enabled; otherwise click the “Start” button then
choose “Run” and on the "Command Line" field, type
“D:SETUP” (substitute the correct CD drive letter for "D:"
as needed).
3. The Setup program will initially copy several startup files to
your hard disk. Read the program license dialog carefully.
4. The drive selection dialog is displayed. The default is
"C:\Program Files\Deloach.aero\DSSLog" , but you may use
the Browse button to type in any drive letter and path you
desire. Click on the "Next" button.
5. Select a “Typical” or “Custom” installation. The Typical
install will install the basic product and typical options. Use the
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“Custom” install to select specific products, such as the
optional airport import databases (military and private).
6. Choose the Program Folder (Group) you want to icons to be
placed into. A suggested default is provided.
7. The installation program will copy a number of files to your
chosen drive and path as well as several files to your Windows
System directory (see the list below for the affected files), then
create the appropriate icons in your Program Folder.
8. Depending in the specific files installed, you may be
required to reboot your computer to complete the installation.
The final dialog will explain this if necessary. Otherwise, an
option to launch your web browser to register on-line will
display. You do NOT need to register if you bought your
software directly from us.
9. Be sure you read the on-line documentation when you’re
first trying out the software for specific details about each
dialog.

Files Installed By DSSLog
In the installation directory:
•
•
•

DSSLOG.EXE, DSSLOG.HLP — the program files

•

UNINST.ISU — Uninstall program log, do not delete if
you want to retain the ability to uninstall DSSLog.

DSSLOG.MDB — your logbook database
*.APT — additional airport import databases you may
choose to import (see on-line help); you can delete these
after importing (or if you don’t want to import them).
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In your Windows directory:
•

DSSAV8N.INI — INI file used by all DS&S applications

No modifications are made to any of your boot or Windows
configuration files (except for adding VSHARE.386 to
SYSTEM.INI in some Windows 3.1 cases). Small files with an
extension of ".LDB" are created for use by the database engine
in the installation directory, paired with the associated ".MDB"
database.

In your Windows System directory:
•

A variety of DLL, VBX, and/or OCX files — shared tools
and DLLS; other applications you own may also use some
of these files.

Network Installation Issues
The license allows for network installation (see the on-line help
file). In a “shared” Windows setup, you may have a problem
copying setup files to the shared directory unless you have
rights to create and write files in the shared Windows directory.
The installation program will report the possibility, you can
attempt to continue the install or get the help of your System
Administrator.
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Section III

DSSLog User Interface Basics
The Main Program Window
The main program window consists of three areas: the menu at
the top of the window, the toolbar of buttons under the menu,
and the body of the main window where various dialogs used
by the program are displayed.
The Toolbar buttons are shortcuts for various menu options.
Whenever you click on any of the buttons labeled “Logbook”
through “Summary” while in DSSLog, the current view will
close and the selected view will display. This is a shortcut for
using the “View” menu option, then selecting the desired view.
The Print button is not functional for every view, but for
views which have reports the Print button will display the
Report dialog for that view, a shortcut over selecting the
Report menu option and choosing a report.
The DSSCalc button will launch DSSCalc Flight Computer if
installed, otherwise it will offer to launch Windows Calc
instead. The Help button displays context sensitive help for
the current view. The Exit button exits the program.
Here's a diagram of the Toolbar:

The Program Views
The “View” menu options and their corresponding Toolbar
buttons will close the current view and display the selected
view. Whenever you start the program, the Logbook View
will display, with the highlight at the bottom of your logbook
table (i.e. the last record in the file). There are six views in the
program, and all of them share a common user interface so that
you have to learn only one basic interface scheme. Here is a
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typical view dialog, sometimes referred to in this manual as a
“list dialog” because all of the views have a list of data items,
displayed in a “grid” which looks somewhat like a spreadsheet:

Notice the set of option buttons displayed at the top of the
dialog identifying the various options available for this list, such
as “Add”, “Edit”, “Help”, etc. You can select any of the options
by clicking on the proper button, or holding down the “Alt” key
plus the underlined letter on the button (for example, press AltA to select the Add button).
Some lists have more than one sorting order available. A
shortcut to choosing the “Sort” button is to simply click on the
header of the column you want to sort by; columns which are
valid sorting keys are displayed with a boldface font in the
column header.
On the list itself, you can use the vertical scrollbar on the right
side to scroll through the list, by dragging the scrollbar marker,
clicking on the arrows at the top and bottom of the scrollbar, or
clicking anywhere inside the scrollbar. A horizontal scrollbar
will display at the bottom of the list if there are more columns
than will fit in the current window.
You can click and drag any of the column edges to temporarily
resize a column for more or less room. You can also
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temporarily move columns or grouped columns around, or
delete columns, by clicking on the column header (nonsorting-key columns only), or right-clicking (click with your
right mouse button instead of the left) the column to delete it.
These changes are all temporary; the next time you display the
list dialog, the columns will be reset to their original state.
For cells of data where the information contained is larger than
the cell, you can simply rest your cursor over the cell for a few
seconds, and a small window will display showing the full
contents of the cell, similar to “balloon help” or “tool-tips”.

The Add/Edit Dialogs
Once you select the Add or Edit option on a view, an Add/Edit
dialog displays based on your current view; for example
clicking “Add” on the Pilots view displays the Pilot Editor
dialog, where you can enter the specific information for each
pilot.
All dialogs have some required entries, and the on-line help
will tell you which fields are required for each dialog.
Many of the dialogs are “tabbed dialogs”, meaning there are
several labeled folder tabs in the main portion of the dialog
that you can click to view different logically grouped portions
of the complete record. Click on a labeled tab at any time
while editing the fields to jump to the portion of data indicated
by the label on the tab.
Many dialogs have entry fields for dates. All date fields have
“spin buttons” attached to them to add or subtract one day at
a time, and drop-down calendar buttons where you can
quickly scroll through dates a month at a time and click on the
desired date when found, for faster data entry.
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Section IV

Running the Program the First Time
The first time you start up the program, there are a few things
you need to do before you begin to enter your logbook entries.
These tables typically represent items which will rarely need
changing, after you originally have set them up.

Initial Setup Tasks
You should complete the following tasks before doing any
logbook data entry. Since the information you enter in steps 1
and 2 are required by the logbook data entry dialog, you must
already have entered these items before you can begin entering
your actual Logbook flight data:
1. Add all the the pilots you intend to track with DSSLog in
the Pilot Information Editor (click the Pilots button on the
toolbar, or select the View-Pilots menu option). For most
people, you will only have to enter one pilot: yourself. You
must enter at least one pilot to use DSSLog!
2. Using your written logbook as a guide, go to the Aircraft
Editor and add in all the aircraft models you find in your
logbook(s), and the Tail Numbers for each model. These
dialogs contain all of the aircraft features (complex, tailwheel,
category and class, etc.) which are needed to construct your
own Logbook Summary reports, so be sure to set up all of the
information correctly for each model.
3. Click on the “Options” menu option to get the Options
Editor and set all of the logbook data entry options. At first,
since you will likely be back-entering old data from your
written logbooks, you will find that the best options for most
fields are “Last Entry”, which copies the data from the
previous logbook entry. This will save you a little time while
entering the old logbook information. After you have caught
up your data entry to the present, you may choose to use
different selections (for example, “Today” as the default date).
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4. If you want to include the military or private airports in your
airport selection list, import them into your Airports table using
the File-Import menu option. If there are special destinations
(non-public or non-US airports, for example) which you would
like to add to the list of airports, bring up the Airport Editor and
manually add them in.
After you import the military or private airport files
MILITARY.APT or PRIVATE.APT, you can delete them from
your program directory to free up 2 Megabytes of disk space.
You can also delete them if you don’t plan on using them.
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Section V

Creating and Printing Reports
Overview
Perhaps the largest benefit of having your logbook on-line is
the ability to quickly construct and print custom reports to let
you view your flight data in various ways-- custom totals,
totals within a date range, currency reports, etc. The Reports
menu option and the Print buttons bring up the various
report dialogs.
All reports can be viewed on the screen or printed to your
printer. In the screen view, there is a printer button as well
so that you can send a report currently displayed on-screen to
the printer. Other buttons on screen reports let you zoom in
and out, scroll up and down a page and jump from page to
page. Click on the “Close” button to shut down the report.
Some reports, such as the Pilot report and the Logbook report,
are predefined and do not require a separate view list dialog; in
these cases choosing the Report submenu option (or clicking
the Print button on the toolbar while a list dialog is displayed)
takes you right to the report dialog where you select the report
options.
Two classes of reports in particular warrant special attention,
however: Summary and Currency reports. Because these are
custom defined by you, there are list dialogs to hold lists of all
the Summary and Currency reports you have defined.

The Summary Report View
Summary reports are a powerful feature of DSSLog. Using
well-chosen summary report definitions, you will often have
no need for custom columns in your logbook data entry dialog,
but will be able to get flight time totals directly from the basic
flight data. For example, you don’t need a column for
“complex time” or “tailwheel time” in your data entry screen,
because you can easily create a summary report which only
totals time only in complex or tailwheel aircraft. In fact, since
Summary
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reports can utilize all of the various characteristics of the aircraft
model table, you should generally avoid defining custom
logbook columns which are based on aircraft characteristics; use
a Summary report instead, and save the user columns for when
you really need them.

The Currency Report View
There are a variety of pilot currency requirements, legally
defined in the FARs, required by employers, or simply your own
personal requirements for being a safe pilot which are based on
calculations derived from your logbook data. DSSLog allows
you to create your own custom currency rules and print reports
identifying whether or not you are current in each requirement.
You should examine the Currency reports which are shipped
predefined in the Currency table to see examples of to create
your own rules.
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Section VI

Periodic Tasks
Backing Up Your Data
One of the reasons you purchased DSSLog was to have an online backup of your written logbook. However, your DSSLog
data also represents an investment of your data entry time as
well, and should be backed up on a regular basis to avoid
complete loss of data after an unfortunate incident such as a
hard drive failure or virus invasion.
One thing about backups has always been true: if it isn’t easy
and painless to do, it simply won’t get done. To make it easy
for you to do regular backups, we have included backup and
restore capability right in the program. The only requirement
is that you have a formatted floppy disk (if you plan on using
floppies as your method of backup) ready to go. Typically you
would use one or more floppies as your backup, though the
program will also allow you to choose a hard disk path as well
(for example, if you have two hard drives or a removable hard
drive available).

Backing Up
Select the “Backup” option from the File menu to display the
following dialog:
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The Backup File Name is a required entry. Click on the
Browse button to get a standard Windows File-Save As
common dialog to enter the path and file name you want to
backup to, or just type it in on the edit box.
You do NOT have to enter a file extension for the backup set,
because backup files always have the file extension “.001”.
The reason is that backups may span multiple floppy disks, and
each disk will have a file extension matching the disk number
(disk 2 has extension .002”, etc.). The “.001” represents the
first disk in the backup set. You will have possibly thousands
of logbook entries before you fill a single 1.4 Meg floppy disk,
however, because the data is heavily compressed during the
backup.
Be sure you have a formatted floppy disk ready for the backup;
the program will not format the disk for you.
Click on the “Save” button to perform the backup, or click the
“Cancel” button to abort the operation. If more than one
floppy disk is required during the backup, the program will
prompt you for the next disk.

Restoring Your Data From Backup
Select the “Restore” option from the File menu to display the
following dialog:
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The Backup File Name is a required entry. Click on the
Browse button to get a standard Windows File-Open common
dialog to enter the path and file name you want to restore from,
or just type it in on the edit box. You do NOT have to enter a
file extension for the backup set, because backup files always
have the file extension “.001”.
Your DSSLog data is stored in a file called “DSSLOG.MDB”.
A checkbox at the bottom of the dialog, if checked, tells the
program to rename your current DSSLog database to
“DSSLOG.BAK” before restoring the database from your
backup floppy. If you have enough disk space available, I
strongly urge you to leave the box checked so that you have a
“backup” copy of your current database in case the Restore
operation cannot be completed (for example, if the backup
floppy disk was damaged).
Be sure you have all of the floppies from the backup set ready
if more than one disk was required.
Click on the “OK” button to perform the restore, or click the
“Cancel” button to abort the operation. If more than one
floppy disk is required during the backup, the program will
prompt you for the next disk.

Repairing and Compressing Your Data
There are a few circumstances in which you may need to
perform large, database-wide operations on your DSSLog
database. Two options for doing this are found under the File Database Tools submenu.
Compact Your Database -- You would Compact your
database if there were a large amount of deleted records in
your data. Records you delete are not physically removed
from the data until you Compact the database.
Repair Your Database -- You would Repair your database if
it appears to be damaged, for example if your lists suddenly
appear incomplete, repeat the same record, or behave
strangely. You should choose Repair first, before you restore
the data from a backup., since you may have added new data
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since your last backup. Things which might damage your data
include turning off your computer without completely exiting
the program, hard drive failure, etc. The database used by the
program is a fully transaction-tracked relational database and
all updates to your data are performed in explicit transactions
to ensure maximum integrity of your data, so in general it
would be unlikely to need to perform this Repair operation;
however, Murphy’s Law virtually guarantees that someone
will need to do this, so I have provided the option to you.
There are no negative effects of running Compact or Repair on
a database which doesn’t require these operations, so feel free
to run them whenever in doubt.

Exporting Your Logbook Entries to Other
Applications
DSSLog has the ability to export your Logbook entries to
comma-delimited ASCII text files so that you can use the
information in other applications, such as spreadsheets or
databases. Choose the “Export” option on the File menu to
display the Export dialog:

The Output File Name is a required entry. The other fields
are optional. Click on the Browse button to get a standard
Windows File-Save As common dialog to enter the path and
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file name you want to export to, or just type it in on the edit
box.
You may optionally enter a specific pilot’s name to export,
and/or a date range of records to select, in the optional filter
frame.
Click on the “Save” button to perform the export, or click the
“Cancel” button to abort the operation.

Importing Airports
The list of Airports in DSSLog is entirely optional: you can
type anything you want in the departure and arrival fields in
your Logbook entries. However, if you want DSSLog to pop
up a list of known airports while entering data so that your
records are as accurate as possible, you should maintain the list
of airports as needed. The default airports list shipped with
DSSLog contains all of the USA public airports.
There are two ways to get new airports into the list: use the
Airport List View, or use the Import Airports menu item on the
File menu.
To import an airport list, on the File menu, select “Import

Airports” to display the following dialog:
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The File Name to Import is a required entry. The other fields
are optional. Click on the Browse button to get a standard
Windows File-Open common dialog to locate the file you want
to import. Two import files are included with DSSLog:
“military.apt” for USA military airports, and “private.apt” for
registered USA private (Restricted) airports. You are free to
construct your own import files as well, and our World Wide
Web site may provide some international files if users submit
them to us as well as an updated list of USA public airports
annually.
You may optionally enter a single country and or a single state
in the two filter edit boxes. This allows you to import, for
example, only the military airports in TN (Tennessee) instead of
all military airports in the US.
The checkbox at the bottom forces the program to delete all
airports in your list before importing the new ones. US pilots
should NEVER choose this option! This is provided for
international pilots who don’t need US airports clogging up their
list, as a means of deleting the default USA public airports
included in the package.
Click on the “OK” button to perform the import, or click the
“Cancel” button to abort the operation.

Airport Import File Definition
Columns

Description

1-25

Airport ID (in the US, the official 3 or 4 character

26-61

Airport Type: Airport, Heliport, Seaplane Base, Ultralight,
Gliderport

62-82

State (In US, the 2 char abbreviation)

83-130

City

131-136

Country

137-178

Airport Name

179-250

Comments (in the supplied files, “Private” and “Military” are
used in the comments to note the airport type)
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Legal Copyright and Software License
This software and program documentation are Copyright © 1996
DeLoach Sales and Software. This software is a commercial product,
and is NOT shareware, freeware, or public domain software.

No-Nonsense License
This software is covered by United States and international copyright
laws. You must treat this software like a book, except that the software
is licensed only to a single individual. You MAY install the software
on more than one computer, so long as ONLY the individual user to
whom the software is licensed uses the software.
Just as a single book cannot be read by two different persons in two
locations at the same time, neither can this software be used by two
different people simultaneously (either on a network of computers or
by making more than one copy of the software), or in fact by anyone
other than the individual user to whom the software is licensed, or you
will be in violation of this license and copyright laws. You MAY
make backup copies of the software for archival purposes only, but not
to give away or sell to other users.
We aren't trying to place any undue restrictions on your usage of our
software, but we expect you to be honest and not cheat our company
(and my family) by making illegal copies of the software for your
friends. We are an honest business, we charge a fair price for good
software, we have in every way possible tried to be up-front with our
customers, and we expect the same treatment in return.
If any of these License terms are objectionable to you, you may return
the software for a full refund.
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